
Refinement and Synthesis

Refinement

컴퓨터로 한 코팅을 더 좋은 코팅으로 만들고자 할 때 컴퓨터로는 “좀더 좋고 또는 좀더 나쁘고”

라는 구분이 어렵기 때문에 기준의 한 수를 정해 놓고 그 수가 어떤 수 보다 작은지 또는 큰지를라는 구분이 어렵기 때문에 기준의 한 수를 정해 놓고 그 수가 어떤 수 보다 작은지 또는 큰지를

구별 하는 기능을 이용하여 평가하는 것이 가장 바람직합니다.

그러므로 컴퓨터가 이에 대한 작동을 시작 하기 전에 우리가 개선되어 져야 할 코팅의 품질

값에 대응한 기준 숫자( Single number )가 설정 되어져 있어야 합니다.

이 기준 숫자( Single number )를 “ Figure of Merit “ 이라고 하는데 이 값은

“Function of Merit” 라고 하는 기능(Function)에 의해 규정되어지며 실제 코팅과

원하는 코팅의 품질 차이를 표시하여 줍니다.

그러므로 코팅 원하는 품질에 가까울 수록 “Function of Merit” 의 값은 작아지며그러므로 코팅 원하는 품질에 가까울 수록 Function of Merit 의 값은 작아지며

만약 “0”이 되면 바로 원하는 코팅과 실제 코팅이 완벽하게 일치하는 것을 의미하며

최적화의 목적은 주어진 제약 조건 하에서 “figure of merit “ 값을 가능한 한 작게 하는데 있습니다.

그러나 변수에 대한 모든 제약을 고려하여 최적화 시키는 방안인 전역 최소화(Global minimum)을

이용할 경우 예를 들어 20층에 20가지 변수(레이어별 두께 값 등)가 있는 경우이용할 경우 예를 들어 20층에 20가지 변수(레이어별 두께 값 등)가 있는 경우,  

약 2x109년(?)이 걸린다고 합니다. 

그러므로 이런 방식은 현실적으로 불가능 하며 국부적 최소화(Local minimum ) 방식이

경제적, 현실적으로 적절한 방안이어서 가장 적합한 국부적 최소화 방식의 사용이 매우 중요한

Refinement 결과를 도출해 낼 수가 있으므로 신속하고 정확한 다양한 방식이 많을 수록 좋은데

본 프로그램에서는 지속적인 업그레이드를 통하여 현재 총 9가지의 R fi t 방식이 있는데본 프로그램에서는 지속적인 업그레이드를 통하여 현재 총 9가지의 Refinement 방식이 있는데

다음과 같습니다. 

“Parameters>Refinement”

9 가지의
Refinement
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1. Target

Target창이 활성화된 상태에서
“ File > Display Setup… “ 
필요한 표시 항목을 선정합니다필요한 표시 항목을 선정합니다. 

1-1. Standard

Context : Target이 적용한 디자인 전후관계 명시.

Incident Angle : 현 입사각 단위로 측정된 값, 이 컬럼이 나오면 자동으로
polarization column (Pol)이 활성화 됩니다.

Weight  : 각 Target의 상대적 중요도를 관리하는데 한 Target의 weight 값이 다른 것과
상대적으로 클 수록 그 Target에서의 결과로 Refinement가 더 많이 유도됩니다.

Target Tolerance : 각 Target의 상대적 수용 가능한 오차 크기.
각 Target =  요구된 값과 실제 값의 차이 ÷ 입력된 tolerance
Target의 타입이 변경되면 해당 타입의 기준 Tolerance 값이 해당 컬럼에 입력되며
기준 Tolerance 값은 “Options menu >Tolerances “ 에서 수정이 가능합니다.기준 값은 p 에서 수정이 가능합니다

Derivative  : 파장 이거나 주파수인 독립 변수에 관계된 Target 타입의 Derivative 순서
목록으로 어느 것이냐 하는 것은 첫 번째 컬럼에 보이는 것으로 정합니다.
“0”은 Derivative를 무시 하는 것을 의미 합니다.

Pol : 입사각이 “0” 아닐 때만 “P,S,Mean” 선택 창이 나타납니다.
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Link : Targets 사이에 배정을 주는 것.

예를 들면 400, 500, 550, 600, 650 그리고 700nm에서 50% 절대 값을 갖는 Target 설정,

400와 425nm, 525nm와 575nm, 675와 700nm을 Link로 분리,

Link번호는 연결된 것끼리 동일한 번호를 사용하며 중요도에 따라 큰 번호 순서로 주며

링크 번호가 입력되면 두 번째 링크된 Target의 요구된 값은 사라지며

각 반사 값의 차이가 Zero가 되어야 하므로 Link Multiplier 1 과 -1이 되어야 한다.

Current Value  : 본 Target에 관한 실제 디자인 수행 결과 값.

Contribution : 전체 merit figure에 대한 Target의 기여도 % . 

1-2. Color

Required Value, Operator은 standard targets과 동일하며 Types은 color 변수 입니다.

각 Target은 source와 observer(색상을 보는 대상)을 명시 해야하며

Mode : 계산되어진 반사 또는 투과 색상을 설정 하는 것으로
Stack에서는 emergent medium에서 반사된 색상을 계산하며
vStack에서는 Mode에서 가능한 결과 치만 가능합니다. 
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에서는 에서 가능한 결과 치만 가능합니다

※ Target창이 활성화된 상태에서 “ File > Display Setup… “   표시 항목을 추가 할 수 있습니다. 



Type 입력 화면의 너무 큰 공간을 피하기 위해 아래와 같이 약어를 사용 합니다.
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1-3. Thickness

Required Value(nm)을 입력하면 다른 변수 들이 나타 납니다.

1-4. Script

선택 사항인 Function이 있을 때만 사용이 가능한 설정 기능 입니다.

※ Target 창이 활성화된 상태에서 다양한 수정 작업은 “ Edit “ 보시면 됩니다.

예)
“ Edit > Generate… “

입력된 수정 내용
이 기존 내용에
추가

입력된 내용으로
새롭게 작성
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2. Simplex

패킹밀도와 레이어를 변동하며 각 iteration 마다 바로 전 디자인 보다 더 나은 디자인을
만들어 내는 가장 빠른 방식으로 본 프로그램 에서 제공하는 Simulated Annealing와 같이
Film Index에 대한 유일한 Refinement 입니다Film Index에 대한 유일한 Refinement 입니다. .

Refine Thicknesses와 Refine Index 
둘 중 모두 또는 하나는 선택 되어져야 한다.

Number of Iterations :  반복 횟수. 
최대 2147483647회최대 :  2147483647회. 
설정된 수 이전에 목표 점에 도달하면 자동으
로 정지되며 “ Final Figure of Merit …“ 안내
창이 나타나면 “확인” 버튼을 누르면 됩니다.

Minimum Merit Function Improvement to 
Update Plot (%) :  최소 개선 율.
현 디자인 보다 입력된 수치 이상으로현 디자인 보다 입력된 수치 이상으로
개선되게 계획, 실행.

Recycle Interval : 재활 주기.
Iteration을 모두 마친 후 Simplex를
열어 처리 과정에서 갇혀있는 local 
minimum을 피하도록 하는 것minimum을 피하도록 하는 것.
“0 “ : 실행 안 함을 의미.

Refine Thicknesses : Refinement에서
조정 되어져야 할 두께.

Starting Thickness Increment : 각 레이어의 두께를 순서대로 이 값 만큼씩 하는데
그 값은 geometrical thickness로 d/λ0  해당 된다.

Refine Index  : Refinement에서 조정 되어져야 굴절율.
패킹 밀도로 굴절률이 조정되며 만약 디자인 파일에 optical thickness는 보이고
Refine Thicknesses가 체크가 안되어 있는 경우 optical thickness는 refinement 하는Refine Thicknesses가 체크가 안되어 있는 경우 optical thickness는 refinement 하는
동안에는 상수가 된다.

Merit Function Power : 값이 클 수록 큰 에러를 허용하는 것으로 공학적 공식에 의해
“2”가 가장 적당하다고 합니다.

Limiting Range for Merit Function : 이 숫자 보다 최악과 최상의 디자인의 merit figures 
차이가 작으면 Simplex 처리를 종료되는 것으로 시작 값으로 “ 0 0000001” 적합
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차이가 작으면 Simplex 처리를 종료되는 것으로 시작 값으로  0.0000001  적합.

※ User Custom Merit Function과 Source File은 선택 사항인 “Function” 과 관련된 것 입니다.



3. Optimac

Optimac 박박센터가 등록한 특허로 synthesis(합성)과 refinement(개선)에
적합한 기술 입니다.

Synthesis에는 각 Refinement 주기가 끝나는 점에서 레이어를 쪼개고, 삽입하고, 추가하여
디자인을 변경하는 다양한 규칙들이 있으며 해당 공정의 후속 진행에 의해 유용하다고
입증될 때 까지 그 변경 사항은 잠정적으로 존재합니다. 

만일 약속된 개선이 안되면 현재 변경된 사항들은 유야무야하게 되고 다른 방법이
그에 적용되어져 진전에 따라 공정이 스스로 계속해서 변화합니다.

그래도 그 변경이 성공적이지 않으면 레이어를 삽입할 적정의 장소를 찾게 됩니다.

이런 찾는 방법은 Needle 기술과 비슷한 점은 있지만 삽입된 레이어는 공정에 의해
결정된 유한의 두께를 갖고 있습니다.

Optimac Parameters dialog  (Optimac 변수 입력 창 )

선택 사항인
Function 사용시에만
적용 가능

Synthesis Step : 합성 시 삽입되는 레이어의 두께로 geometrical thickness인 d/λ0 이며
일반적으로 0.1 ~ 0.3을 추천하며 이 변수가 클수록 삽입된 레이어의 두께는 더 크게
되는데 가장 적합한 수로는 0.3이 됩니다.
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Synthesis Parameter :  만족할 만한 figure of merit  얻기 위해 계속적으로 레이어 합성 작업을
하는데 마지막 결과 치가 전에 했던 결과 치보다 나쁜 데도 마지막 결과를 새로운 디자인으로
선정이 되도록 하는 것으로 synthesis parameter 보다 figure of merit이 작으며 그 값은
0.2 ~2.0까지 가능한데 0.2가 적정 합니다. 

Initial Search Step : 탐색 백터의 초기 길이(보폭, geometrical thickness )로 그 값이
탐색 영역의 초기 길이인 Initial Search Width과 같게 정해 집니다.

Number of Synthesis Cycles  : 각 합성 작업 사이에 refinement 의 반복 횟수로 40 또는 50으로 설
정 합니다.  ( 만약 “0”이 입력되면 Refinement만 실행됩니다.)

Merit Function Power : 값이 클 수록 큰 에러를 허용하는 것으로 공학적 공식에 의해

Limiting Range for Merit Function : 디자인이 이 값 보다 작은 Figure of Merit를 갖게되면
공정이 종료됩니다. 적합한 값으로 되며 0.01 입니다.

값이 클 수록 큰 에러를 허용하는 것 로 공학적 공식에 의해
“2”가 가장 적당하다고 합니다.

Maximum Number of Layers  :  너무 크게 잡으면 계속해서 얇은 레이어를 계속 추가하게 되므로
최소 100 이 되어야 하며 공정 중에 모니터링이 가능하여 수동으로 제어가 가능 합니다.  

Number of Iterations :   refinement 공정이 이 반복 수에 닿으면 정지됩니다.
Synthesis Cycles이 zero인 경우는 300 이상을 권장하며 그 외는 25 ~50 추천 합니다.

Minimum Merit Function Improvement to Update Plot  :  공정에 대한 Plot을 갱신해 주는 것
으로 만일 매번 Plot을 하게되면 시간이 많이 소요되므로 주어진 수치 만큼의 비율 (%)로
Merit Function이 향상 됐을때만 plot을 합니다.

Synthesis Materials :  합성(synthesis)모드 에서는
최소 두 개 이상의 물질이 선정 되어야 하는데
초기 디자인에서 사용되는 물질이 자동으로초기 디자인에서 사용되는 물질이 자동으로
입력 되어집니다.
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4. Simulated Annealing 

Simulated Annealing은 특별히 새로운 기술은 아니며 박막 코팅에 많이 적용되지도 않습니다. 

각 새로운 변화마다 새로운 figure of merit가 계산되어 항시 더 좋은 디자인만각 새로운 변화마다 새로운 figure of merit가 계산되어 항시 더 좋은 디자인만
선택 되지만 가끔 공정이 계속됨에 따라 점차 줄어드는 개연성을 갖고 있는
디자인이 채택 될 수도 있습니다.

확실한 초기 디자인이 업을 때 가장 유효하며 입사 영향의 각을 갖고 있는 사양, 
특히 다른 Refinement 방식들의 처리가 지지부진 할 경우 좋은 대응 방안이 될 수 있습니다.

Initial Temperature : 초기 온도로 100정도 주는데 공정에 따라 가감이 가능 합니다.
Final Temperature  : 최종 온도 “0” 설정

선택 사항인
Function 사용시에만 적용 가능

Number of Iterations : 반복 횟수로 최대 2,147,483,647인데 적정 값은 30,000 이상.

Minimum Merit Function Improvement to Update Plot  :  공정에 대한 Plot을 갱신해 주는 것으로
만일 매번 Plot을 하게되면 시간이 많이 소요되므로 주어진 수치 만큼의 비율 (%)로
Merit Function이 향상 됐을때만 plot을 합니다.

Merit Function Power : 값이 클 수록 큰 에러를 허용하는 것으로 공학적 공식에 의해 “2”가Merit Function Power : 값이 클 수록 큰 에러를 허용하는 것으로 공학적 공식에 의해 2 가
가장 적당하다고 합니다.

Merit Function Limit : 디자인이 이 값 보다 작은 Figure of Merit를 갖게 되면 공정이 종료됩니다.  
적합한 값으로 되며 0.01 입니다.

Changes :  Absolute 또는 Relative. 
Absolute를 선택, 0.2가 입력되면 레이어 두께 변화가 0.2×λ0 ( 현 레이어 두께) 만큼 더해지며
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Relative 선택하면 현 값에서의 0.2씩 레이어 두께가 변경 됩니다.  Relative는 얇은 레이어는
거의 변화가 없을 수가 있으므로 초기 에는 Absolute 를 권장 합니다. 



Initial Standard Deviation : 두께 변동의 초기 값으로 경험에 의해 조정이 가능하나
초기 디자인에서는 0.0002 또는 0.0001 적당 합니다. This can be changed with experience 

Final Standard Deviation : 최종 두께 변동으로 가장 이상적인 것은 zero 입니다.

Index의 Changes Initial Standard Deviation Final Standard Deviation는 위의 두께 부분과Index의 Changes, Initial Standard Deviation, Final Standard Deviation는 위의 두께 부분과
의미는 같은데 대상이 Index에 해당 됩니다. 

Common Scaling :  이 박스가 체크되면 같은 물질의 모든 레이어는 같은 굴절률을 보여 주며
체크가 안되어 있으면 각각 독립적으로 처리 됩니다.

5 Conjugate Gradient5. Conjugate Gradient 

Conjugate Gradient refinement 는 파생된 정보로 Merit Function 면의 국부 경사를 결정하는
방식의 한 종류로 레이어 두께를 조정하여 디자인을 개선하는 것으로 매우 빠르다는 장점이
있습니다. ( Local slope of the Merit Function surface ) 

Merit Function Power : 값이 클 수록 큰 에러를 허용하는 것으로 공학적 공식에 의해
“2”가 가장 적당하다고 합니다2 가 가장 적당하다고 합니다.

Limiting Range for Merit Function : 디자인이 이 값 보다 작은 Figure of Merit를 갖게되면
공정이 종료됩니다. 적합한 값으로 되며 0.01 입니다.

Maximum Iterations :  이 값에 이르면 공정을 끝나는 것으로 1000 적당 합니다.

Minimum Merit Function Improvement to Update Plot  :  공정에 대한 Plot을 갱신해 주는 것으p p 공정에 대한 을 갱신해 주는 것
로 만일 매번 Plot을 하게되면 시간이 많이 소요되므로 주어진 수치 만큼의 비율 (%)로
Merit Function이 향상 됐을때만 plot을 합니다.

Termination Match Count : Merit surface의 기울기가 너무 작으면 공정을 계속 하기가 어렵게
되어 공정이 끝나기 전에 몇 번의 매우 작은 기울기를 받아 들려야 하는 것을 설정.
이 값을 (-)로 하면 매우 작은 기울기 때문에 공정이 끝나지 않게 됩니다.
“-2”를 추천 하지만 합성(synthesis)을 하기 위해서는 “2”가 더 유용 합니다.
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6. Quasi-Newton 

Quasi-Newton refinement 또한 파생된 정보로 Merit Function 면의 국부 경사를 결정하는
방식의 한 종류로 레이어 두께를 조정 하는 것은 Conjugate Gradient 와 같지만
merit surface의 두번째 파생 물의 추정 치를 포함한 기술입니다merit surface의 두번째 파생 물의 추정 치를 포함한 기술입니다.
( Local slope of the Merit Function surface ) 

Merit Function Power : 값이 클 수록 큰 에러를 허용하는 것으로 공학적 공식에 의해
“2”가 가장 적당하다고 합니다.

Limiting Range for Merit Function : 디자인이 이 값 보다 작은 Figure of Merit를 갖게되면
공정이 종료됩니다. 적합한 값으로 되며 0.01 입니다.

Maximum Iterations :  이 값에 이르면 공정을 끝나는 것으로 1000 적당 합니다.

Minimum Merit Function Improvement to Update Plot  :  공정에 대한 Plot을 갱신해 주는 것으
로 만일 매번 Plot을 하게되면 시간이 많이 소요되므로 주어진 수치 만큼의 비율 (%)로
Merit Function이 향상 됐을때만 plot을 합니다.

Termination Match Count : Merit surface의 기울기가 너무 작으면 공정을 계속 하기가 어렵게Termination Match Count : Merit surface의 기울기가 너무 작으면 공정을 계속 하기가 어렵게
되어 공정이 끝나기 전에 몇 번의 매우 작은 기울기를 받아 들려야 하는 것을 설정.
이 값을 (-)로 하면 매우 작은 기울기 때문에 공정이 끝나지 않게 됩니다.
“-2”를 추천 하지만 합성(synthesis)을 하기 위해서는 “2”가 더 유용 합니다.

Recycle Interval :  박막 코팅의 merit surface는 포선형으로 나타나 수렴에 실패 또는
너무 더딘 결과로 두 번째 파생 물의 추정치 찾기가 어려울 수도 있습니다. 
그러므로 첫 번째 파생 물을 지우고 다시 시작하는 것이 때때로 유용 할 수가 있는데 이에 대한
Refinement의 재 시작 반복 간격이 필요한데 “10” 이 적당하며 “0”을 입력하면 자동으로
Recycle이 중지 됩니다 . 
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7. Needle Synthesis 

Needle Synthesis 방식은 레이어를 추가 하는 Needle과 Conjugate Gradient 방식을 조합한

것으 팅을 정 하게 위해 N dl 방식에 의해 Z 두께의 새 운 레이어를 추가 하는데것으로 코팅을 정교하게 위해 Needle 방식에 의해 Zero 두께의 새로운 레이어를 추가 하는데

Conjugate Gradient는 새로운 레이어의 두께가 Zero 값을 변화시키며 개선하는 동안

다른 레이어 두께들도 Merit Figure를 개선하는 방향으로 변경되며 이 공정은 이상적인

디자인에 또는 정해진 반복 횟수(Number of Cycle )에 도달할 때가지 반복 되어집니다.

Number of Synthesis Cycles  : 레이어를 삽입하는 Needle Synthesis의 횟수.

Merit Function Limit : 디자인이 이 값 보다 작은 Figure of Merit를 갖게 되면 공정이 종료됩니다.       
초기 적합한 값으로는 0.001 입니다.

Minimum New Thickness :  개선 공정 동안 새로 삽입된 레이어가 이 최소 두께에 도달하지
않으면 좀더 물질이 필요한 것으로 간주하여 디자인에 앞 뒤에않으면 좀더 물질이 필요한 것으로 간주하여 디자인에 앞,뒤에
추가 시키는데 단위는 항상 nm. 

Minimum Improvement (%) : 개선 공정 동안 한 사이클에서 개선이 이 값에 못 미치게 되면
좀더 물질이 필요한 것으로 간주하여 디자인 앞,뒤에 추가
시키는데 단위는 개선 %. 

Maximum Number of New Needles :  각 cycle에서 추가되는 zero 두께인 레이어의 최대 수로
일반적으로 “ 1 “ 인데 만일 레이어의 총 수가 크게 될 것
같으면 초기 값으로 “ 3 “ 적당합니다.

Compact Thickness : 이 수치 보다 더 작은 두께(nm)를 갖고 있는 레이어는 모든 compact cycle         
에서 삭제됩니다.

Compact Interval :  디자인을 컴팩트하게하는 간격으로 zero인 경우 디자인의 컴팩트는 진행이
안됩니다
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안됩니다.

※ Conjugate Gradient Parameters와 Synthesis Materials 탭은 전 에 설명한 내용을 참고 하세요.



8. Differential Evolution 

가장 적합한 것의 선정과 변형을 통하여 한 디자인 군(population)의 조정으로 문제를 해결하기
위한 좀더 좋은 해결책입니다위한 좀더 좋은 해결책입니다.

공정은 시작 디자인에 위치한 한 영역에서의 랜덤 두께 또는 패킹밀도를 갖고 있는 디자인 군으로
부터 시작되며 두께와 밀도 리미트는 디자인의 최대, 최소 리미트 또는 에러 패러미터(error 
parameters )로 명시되어집니다. 
시작 영역은 매우 넓을 수가 있어 처음부터 좋은 디자인을 필요로 하지는 않습니다.

한 군 (population) 이 성립되어지면,  Merit Figure가 충분히 작아 졌을 때 또는p p g
대들( generations)의 최대 수가 생성 됐을 때 까지 이 공정은 전 대 (generation) 에서부터
새로운 디자인의 대(generation)를 계속 만들어 냅니다.

현 대 (generation) 에서 최고, 최악 디자인의 Merit Figure 차가 사용자가 정한 값 보다 아래로
떨어졌을 때도 공정이 중지 되는데 이것은 하나의 디자인으로 수렴이 되어져 공정을 정지하게
하는 것으로 요구된 Merit Figure 값에 도달하지 못한 디자인이 될 수도 있습니다.

표준 방식으로 구 대에 있는 3 개의 디자인을 랜덤하게 선택하여 새로운 대의 요소로 구성하여표준 방식으로 구 대에 있는 3 개의 디자인을 랜덤하게 선택하여 새로운 대의 요소로 구성하여
한 디자인을 만드는 것으로부터 시작으로 합니다.

첫 디자인은 각 패러미터를 차례대로 취하면서 Scale Factor로 곱하여진 3번째 디자인과 2번째 디자
인에 있는 동일한 패러미터의 차에 그 것을 더해 변형되어 지며,  그 다음, 조정되어져야 할
디자인은 이 변형된 디자인과 교차하게 됩니다.

교차확률( Crossover Probability )은 랜덤하게 발생하며 이 것은 조정되어진 디자인에 있는교차확률( Crossover Probability )은 랜덤하게 발생하며 이 것은 조정되어진 디자인에 있는
패러미터가 변화해야 하는지를 결정하는데 만약 변화가 없으면 그대로 남으며 변화가 있으면
변형된 디자인에서 상응하는 패러미터로 대체됩니다.

이 교차된 디자인의 Figure of Merits는 변경되지 않은 초기 디자인과 비교하여 만일 그 값이
좀더 작으면 그 변형은 새 대에 더해 지며 그렇지 않으면 초기 디자인이 새 대의 요소가 됩니다.
새 대는 구 대의 군에 있는 모든 디자인이 고려되어 졌을 때 완성 됩니다.

Diff i l E l i 은 근본적으 많은 디자인을 평가해야 하Differential Evolution은 근본적으로 많은 디자인을 평가해야 하므로
다른 방식보다 시간이 많이 걸릴 수가 있는 반면 매우 발전된 우수한 기술 입니다.

Population Generation :  설계 군의 크기 관리

Minimum Size : 각 군(population)의 최소 디자인 수

Maximum Size : 각 군의 디자인 수가 이 수를 넘지 않는다.

Scale Factor : 레이어의 수에 이 값만큼 곱한
각 군의 디자인 수로 Maximum Size와 같거나 작게
됩니다.
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Refine Thicknesses : 두께 개선 실행

Range :  초기 영역을 정의하는 3 개의 시작 범위Thickness Limits : 디자인 파일에서
최대,최소 두께로 부터 영역의 limit를 갖는다.

2 × Error Limits : 최소 두께는 mean error이하인 2 standard deviations이 되며
최대 두께는 mean error이상인 2 standard deviations 두께로 됩니다. 

3 × Error Limits  : 최소 두께는 mean error이하인 3  standard deviations이 되며
최대 두께는 mean error이상인 3 standard deviations 두께로 됩니다. 

Refine Index :  패킹 밀도를 통한 개선 실행

Range :  
Density Limits : 디자인 파일에서 최대,최소 밀도로부터 취한다.

2 × Error Limits : 최소 밀도는 mean error이하인 2 standard deviations이 되며
최대 밀 는 이상인 2 d d d i i 밀 됩니다

Common Scaling : 패킹 밀도의 변화가 같은 물질을 갖고 있는 모든 레이어에 적용 여부

최대 밀도는 mean error이상인 2 standard deviations  밀도로 됩니다. 

3 × Error Limits  : 최소 밀도는 mean error이하인 3  standard deviations이 되며
최대 밀도는 mean error이상인 3 standard deviations 밀도로 됩니다. 

Maximum Number of Generations :  이 값에 대(generations)의 수가 도달하면 Refinement가
종료 됩니다.

Crossover Probability : 교차확률로 각 디자인에서 패러미터의 수정 비율을 관리 하는 것으로
“ 0.9”가 시작 값으로 적당.

Scale Factor :  디자인의 랜덤 변동성을 관리하는 것으로 값이 클수록 더 많은 변동성을 갖은
디자인 군을 만들어 내며 일반적으로 0과1 사이의 값이 주어지는데
“0.8” 이 시작점으로 적합합니다.

Strategy : 새로운 디자인을 생성 시키는 방법.

Random  : 위에 언급된 방식, 세 개의 패러미터 차이를 이용하여 랜덤하게 변경.
위에 언급된 것으로 처음 시범적 시행 시 적합.

Local to Best : 빠른 수렴

Best : 작은 군과 빠른 수렴

Random per Vector Dither : 랜덤 방식과 같지만 Scale Factor가 작은 지터(jitter)를 갖는다.

Random per Generation Dither :  각 대별로 처음부터 Scale Factor 랜덤하게 변경.

Random Either Or : 두 패러미터의 차이를 이용하여 랜덤하게 변경
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Random Either Or : 두 패러미터의 차이를 이용하여 랜덤하게 변경. 
(Random은 3 개 패러미터를 사용 하듯)



Merit Function 

Merit Function Power 
값이 에러를 허용하 것값이 클 수록 큰 에러를 허용하는 것으로
공학적 공식에 의해 “2”가 가장 적당.

End when Merit Figure <: 
Merit figure값이 이 수치 보다 작거나
같을 때 refinement가 멈춥니다.

End when Merit Figure Range <: 
최상과 최악의 Merit figure 차가
이 수치 보다 수치 보다 작거나
같을 때 refinement가 멈춥니다.

Minimum Merit Figure Improvement to Update Plot(%) 
초기 최상의 fi f it 에 대한 Pl t을 하고

선택사항인 Function이 있을
경우 적용 가능.

Number of Trials : 만일 이 값이 “0”보다 크면 Errors tool이 시험 디자인으로 부터

초기 최상의 figure of merit 에 대한 Plot을 하고
그 이후부터 최상의 figure of merit 값이 이 비율만큼
개선이 있을 때만 업데이트 됩니다.

경우 적용 가능.

Number of Trials 발생시키며 이 디자인들의 각 Merit Figure가 계산되어지며 최악의 Merit Figure가 시
험 디자인의 Merit Figure 배당된다.
만일 값이 “0” 이면 다른 refinement  방식처럼 한 시험 디자인에만 의존하여 Merit Figure 를
계산 합니다.

Re-randomize : 변형된 디자인을 만들기 위해 사용되는 랜덤 수의 대(generation)을 관리 하는데

“Never”로 놓으면 랜덤 수가 한번 정해지면 전체 refinement에 사용되며 이런 경우
Refinement 동안에 같은 디자인은 같은 merit figure를

“Each Generation” 놓으면 새로운 랜덤 수의 집합이 각 대의 초기에 발생되며

“Each Mutation” 놓으면 디자인이 변형이 생길 때마다 새로운 랜덤 수의 집합이
만들어 지며 이런 경우 동일한 대에 있는 같은 디자인이 다른 merit figure를 가질 수도 있습니다.

Materials Tab은 전 설명과 동일.
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프로그램 버전 9.9 이상에서는 새롭고 중요한 Refinement(최적 코팅 개선) Tool로
“Non-Local Refinement” 지원 됩니다. 

9. Non-Local Refinement 

지원 됩니다

Refinement 기법은 Differential Evolution과 Optimac 기법을 제외하고는 디자인을
가장 최소화 하는 길을 찾아 내는 것으로 기법 별로 과정과 결과가 다를 수가 있어
일반적으로 어떤 것이 최상이라고 선정 하기가 어렵습니다.

통계 기반의 기법을 사용하는 Simulated Annealing과 Differential Evolution도 최소화를
찾아내는 방식이지만 같은 기법의 “Non-Local Refinement” 은 다양한 디자인 시작 점을찾아내는 방식이지만 같은 기법의 Non Local Refinement  은 다양한 디자인 시작 점을
사용하여 타 방법보다 훨씬 더 강력하고 정확한 결과를 도출해 내는 기법입니다.

상단 메뉴에서

“ParametersParameters
> Refinement 
> Non-Local Refinement “

두 디자인이 동일한 경우 “materials to use “ 이용하여 Materials 사양 변경이 가능하며
Number of Starts : 디자인 시작 점의 수
Thickness Strategy :  임의의 두께 생성의 범위.

1)  Thickness Limits로 설정하면 디자인 창에 설정되어 있는 최소/최대의
Physical 또는 Optical Thickness Limits가 됩니다.

2) 2 x Error Limits로 설정하면 아래 Errors tool에 있는 값으로 되는데
최 두께는 낮은 의 2 hi k d d d i i 이 되며최소 두께는 낮은 mean error의 2 x Thickness standard deviations이 되며
최대 두께는 높은 mean error의 2 x Thickness standard deviations 가 됩니다.

3) 3 x Error Limits는 2)번과 같으나 각 3 x Thickness standard deviations이 됩니다.
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Index Strategy :  임의의 Packing Density 생성의 범위.
1)  Density Limits로 설정하면 디자인 창에 설정되어 있는 최소/최대의

Density Limits가 됩니다.
2) 2 x Density Limits로 설정하면 아래 Errors tool에 있는 값으로 되는데) y 설정하면 아래 에 있는 값 되는데

최소 두께는 낮은 mean error의 2 x Density standard deviations이 되며
최대 두께는 높은 mean error의 2 x Density standard deviations 가 됩니다.

3) 3 x Density Limits는 2)번과 같으나 각 3 x Density standard deviations이 됩니다.

Do Not Plot Progress  : Refinement 수행 중 Plot 처리를 하지 않아야 수행 속도가
빠르므로 선택 박스 클릭.

Refinement Method  : 두께 값 또는 Packing Density 값은 선택한 Refinement(개선) 방
식의 기량과 그 방식에 입력된 패라미터 값이 얼마인가에 따라 개선 되기도 하고
안되기도 합니다. 이용 가능한 방식으로 Simplex, Optimac, Conjugate Gradient과
Quasi Newton이 있으며 Optimac이 사용되는 경우 Number of Synthesis Cycles은
Optimac Refinement Parameters에 설정된 값과 관계없이 항상 “0”이 됩니다.

“Materials to use “ 탭을 선택하면 Material 대체가 가능 합니다.

Change Materials in Layers를
체크하고
“Add”
“Remove”를 이용 변경.

Maximum Number of Designs : Design Similarity 기준에 따라 Refinement한
“Merit of Figure“  다른 경우의 최대 수, 
보여지기만 하고 파일 저장은 불가능 합니다.
“Merit of Figure“ 상세 내용은 한글 매뉴얼에서 “Refinement” 참고 하세요.
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“Refinement” 버튼을 클릭하면 실행.

실행 중 임의로 멈추어 재고가 필요한
경우 “Pause” 버튼을 눌러 수정이 또는
현 지점의 디자인 파일 저장이
가능 합니다.
Refinement를 보면서 최상의 디자인이
나타나면 “Save Best Design” 으로
저장 가능합니다.저장 가능합니다

이와 같이 최상의 디자인을 찾을 때
까지 Simplex, Optimac, Conjugate 
Gradient과 Quasi Newton 방식을
선택 Refinement를 하면 됩니다.

“A” : 중심에서 반영된 디자인,
“B” : 같은 방향으로 중심에서 두 배정도
이동된 곳에서 반영된 디자인. 

Maximum Number of Designs :  값이 10으로 설정된 경우
디자인 Refinement를 50회 돌린 후 “Merit of Figure“  
다른 경우가 2회 발생, 1회와 그외 49회는 동일 값이라는 것을
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다른 경우가 2회 발생, 1회와 그외 49회는 동일 값이라는 것을
보여 줌.


